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Residential Systems Control of LED Lighting (120V) 

1.0    Overview 
 

Light Emitting Diode (LED) lighting is becoming more prevalent in the marketplace and is often 

being implemented in residences in place of less efficient lighting load types. Demand will 

continue to increase for the high efficacy LED lighting and it is as important as ever to 

understand the various types of LED technology and how Lutron's Residential System product 

families control these technologies. This application note will discuss which Residential Systems 

controls can be used with specific LED technologies available in the market. 
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2.0    LED Tools and Resources 
 

Throughout this application note, various LED and Lighting Control technologies will be 

referenced such as 0-10V dimming, DMX 512, forward and reverse phase control. For more 

detailed information on these technologies, please refer to the Controlling LEDs White Paper 

(p/n 367-2035) which is available at www.lutron.com/led, by clicking on the White Papers link 

under the Resources tab of the LED light sources page. 

 

It is also important to note that Lutron performs its own LED testing with lamps/fixtures from a 

multitude of 3rd party manufacturers. Lamps/fixtures that pass the full set of testing and meet the 

technical and performance requirements are deemed “Recommended.” Recommended 

lamps/fixtures are then placed into the LED Product Selection tool, along with their Report 

Cards which detail product specific performance. The Product Selection Tool is a drop down 

menu selection tool which can help one find Recommended lamps/fixtures based on Lamp 

Manufacturer, Lamp/Fixture type, or even Lutron product family. The Product Selection Tool is 

located at www.lutron.com/ledtool. 

A video on how to use the tool can be found in the LED section of lutron.com. Click here to view 

the video. 

3.0    LED Technology and Residential Systems Applications 
 

This section focuses on the specific variations of LED technologies which are prevalent in the 

market today and how the technologies interact with RadioRA 2 and Homeworks QS products. 

For more information on specific LED technology variations, as well as Product Compatibility, 

please visit www.lutron.com/led.  

http://www.lutron.com/led
http://www.lutron.com/ledtool
http://www.lutron.com/SiteCollectionDocuments/javascript/Flowplayer/VideoPlayer.html?PLAY=rtmp://qrqghhfh63e5.rtmphost.com/ra2training/LED%20Product%20Selection%20Tool.mp4&iframe=true&width=814&height=514
http://www.lutron.com/led
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3.1    Line Voltage LED Control with Integrated Drivers (LEDi) 

 

LED lamps/fixtures with integrated drivers are common. Many are direct replacements of 

incandescent lamps with the driver residing in the base of the lamp itself. In these cases, the 

dimmer is actually sending a signal to the driver which subsequently controls the lighting 

element. The driver technology varies greatly from lamp to lamp. Some integrated drivers work 

well with forward phase, triac-based dimmers, while others perform better with reverse phase 

dimming. 

The following chart displays the wall mounted dimmers which are UL Listed to control up to 

150W of recommended LED lighting loads. To determine if the dimmer is compatible with 

specific LEDi lamps, refer to the LED Product Selection Tool at www.lutron.com/ledtool. 

RadioRA 2 HomeWorks QS (120V) 

RRD-6NA HQRx-6NA 

RRD-6CL HQRx-6ND 

RRD-10ND HQRx-6CL 

 HQRx-10ND 

 HWx-6ND 

 HWx-10ND 

  

The following chart displays the wall mounted dimmers which are UL Listed to control up to 

250W of recommended LED lighting loads. To determine if the dimmer is compatible with 

specific LEDi lamps, refer to the LED Product Selection Tool at www.lutron.com/ledtool. 

RadioRA 2 HomeWorks QS (120V) 

RRT-G25LW HQRT-G25LW 

RRT-GHxB HQRT-GHxB 

RRT-G5NEW HQRT-G5NEW 

 

The following chart displays the dimmers which are UL Listed to control up to 100W of 

recommended LED lighting loads. To determine if the dimmer is compatible with specific LEDi 

lamps, refer to the LED Product Selection Tool at www.lutron.com/ledtool. 

RadioRA 2 HomeWorks QS (120V) 

RRD-3LD HQR-3LD 

RRD-3PD HQR-3PD 

RRD-HNx HQRx-HNy 

RRD-Hx HQRx-Hy 

 

  

http://www.lutron.com/ledtool
http://www.lutron.com/ledtool
http://www.lutron.com/ledtool
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It is also possible to control these types of LED lamps with centralized dimming modules and 

interfaces. To determine if the dimming module is compatible with specific LEDi lamps, refer to 

the LED Product Selection Tool at www.lutron.com/ledtool. 

RadioRA 2 HomeWorks QS (120V) 

Grafik Eye QS (QSGRJ-xP) Grafik Eye QS (QSGRx-yP) 

LQRJ-WPM-6P-120 LQRJ-WPM-6P-120 

 HW-RPM-4U-1201 

 HW-RPM-4A-1201 

 GP (Harrier) Card1 

 

3.2    Line Voltage LED Control with External Drivers 

 

Some LED fixtures on the market have the LED lighting element separate from the driver. The 

driver fits into the system similarly to that of fluorescent ballasts, mounting within the fixture. As 

with integrated drivers, the dimmer is actually controlling the driver, which then controls the 

lighting element appropriately. To determine if the dimming control is compatible with a specific 

LED lamp with external driver, refer to the LED Product Selection Tool at 

www.lutron.com/ledtool. 

RadioRA 2 HomeWorks QS (120V) 

RRD-6NA HQRx-6NA 

RRD-6CL HQRx-6ND 

RRD-10ND HQRx-6CL 

RRT-G25LW HQRx-10ND 

RRT-GHxB HWx-6ND 

RRT-G5NEW HWx-10ND 

RRD-HNx HQRT-G25LW 

 HQRT-GHxB 

 HQRT-G5NEW 

 HQRx-HNy 

 

RadioRA 2 HomeWorks QS (120V) 

RRD-3LD HQR-3LD 

RRD-3PD HQR-3PD 

 

RadioRA 2 HomeWorks QS (120V) 

Grafik Eye QS (QSGRJ-xP) Grafik Eye QS (QSGRx-yP) 

LQRJ-WPM-6P-120 LQRJ-WPM-6P-120 

 HW-RPM-4U-1201 

 HW-RPM-4A-1201 

 GP (Harrier) Card1 

                                                
1
 Requires a system keypad to control the centralized lighting zones of this device 

http://www.lutron.com/ledtool
http://www.lutron.com/ledtool
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Lutron manufactures its own LED Driver, part of the Hi-

lume product family. The Hi-lume A Series LED driver 

from Lutron offers smooth and continuous LED 

dimming with a 1% low end for all approved LED 

fixtures. The A Series driver is compatible with Lutron 

Ivalo lighting fixtures as well as 3rd party fixtures and is 

available in both constant current and constant voltage 

configurations. The A Series driver is available in two 

formats from an input standpoint: forward phase 

control and 3 wire control. A list of current approved 3rd party fixtures is available from 

www.lutron.com (p/n 368-2817). The LED Product Selection Tool, at www.lutron.com/ledtool, 

can also be used to determine compatibility. Many 3rd party fixtures can be ordered to ship with 

the Lutron driver built into the fixture. 

For control of the 3 wire Lutron Hi-lume A Series LED driver, the 120/277V 3 Wire Fluorescent 

Dimmer can be used. The brass terminal provides a constant hot for the driver(s) while the 

orange control wire passes the control signal to the driver(s) in order for the driver(s) to 

determine the light output necessary to match the desired light level output. 

RadioRA 2 HomeWorks QS (120V) 

RRD-F6AN-DV HQRx-F6AN-DV 

 

For control of the forward phase Lutron Hi-lume A Series LED driver, neutral based Residential 

Systems products can be used for control. These products include both local and more 

centralized control options. Note that phase selectable or adaptive products must be set to 

forward phase. 

RadioRA 2 HomeWorks QS (120V) 

RRD-6NA HQRx-6NA 

RRD-10ND HQRx-6ND 

Grafik Eye QS (QSGRJ-xP) HQRx-10ND 

LQRJ-WPM-6P-1202 HWx-6ND 

RRT-G25LW HWx-10ND 

RRT-G5NEW Grafik Eye QS (QSGRJ-xP) 

RRT-GHxB LQRJ-WPM-6P-1202 

RRD-HNx HW-RPM-4U-1202 

 HW-RPM-4A-1202 

 GP (Harrier) Card2 

 HQRT-G25LW 

 HQRT-G5NEW 

 HQRT-GHxB 

 HQRx-HNy 

 

                                                
2
 Requires a system keypad to control the centralized lighting zones of this device 

http://www.lutron.com/
http://www.lutron.com/ledtool
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3.3    0-10V (Current Sink) 

 

With 0-10V dimming, there are two methods for control of the LED light source. The 0-10V 

dimming method is determined by which device is the 0-10V source for the LED lighting. In 

current sinking, a driver provides the 0-10V source and a separate device controls the ballast. In 

our Residential Systems, there are a few ways to control this type of technology. Again, refer to 

the LED Product Selection Tool for a list of compatible products (www.lutron.com/ledtool). 

 

RadioRA 2 HomeWorks QS (120V) 

GRX-TVI3 GRX-TVI3 

LMJ-5T-DV-B4 GRX-TVM2 Module4 

 LMJ-5T-DV-B4 

 

3.4    0-10V (Current Source) 

 

The other type of 0-10V dimming technology is called current source where the control device is 

providing the source to the LED lighting as opposed to a driver. Refer to the LED Product 

Selection Tool for a list of compatible products (www.lutron.com/ledtool). 

RadioRA 2 HomeWorks QS (120V) 

LMJ-5T-DV-B4 GRX-TVM2 Module4 

 LMJ-5T-DV-B4 

 

3.5    Pulse Width Modulation (PWM) Control 

 

PWM is a control protocol implementing a square wave signal, utilizing the corresponding on 

and off time ratio, within a fixed period of time per cycle, to determine the intensity level. Per IEC 

standards, maximum light level is obtained when providing more off time than on time. Refer to 

the LED Product Selection Tool for a list of compatible products (www.lutron.com/ledtool). 

HomeWorks QS (120V) 

GRX-PWM-250 

GRX-TVM2 Module4 

 

  

                                                
3
 Requires a neutral wire dimmer to control 

4
 Requires a system keypad to control the centralized lighting zones of this device 

http://www.lutron.com/ledtool
http://www.lutron.com/ledtool
http://www.lutron.com/ledtool
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3.6    Digital Addressable Lighting Interface (DALI) Control 

 

DALI is another form of low voltage lighting control that is used to send digital intensity 

information to an LED driver or multiple drivers. Refer to the LED Product Selection Tool for a 

list of compatible products (www.lutron.com/ledtool). 

HomeWorks QS (120V) 

GRX-TVM2 Module5 

 

3.7    EcoSystem 

 

EcoSystem is Lutron’s DALI extension, designed to ensure compatibility between all EcoSystem 

controls and EcoSystem ballasts and drivers. Digital information is passed from the control to 

the ballast or driver via a two wire communication bus or loop which can contain up to 64 

ballasts or drivers. Any fixture containing an EcoSystem driver or Eco Enabled chip will be able 

to activate to an EcoSystem control. 

HomeWorks QS (120V) 

LQSE-2ECO5 

Grafik Eye QS (QSGRJ-xE) 

 
 

3.8    DMX512 Control 

 

DMX512 is yet another low voltage lighting protocol and integration protocol which is often 

utilized with Cyan-Magenta-Yellow (CMY) or Red-Green-Blue (RGB) lighting technology which 

utilizes three different LED colors to produce colors throughout the entire visible spectrum. 

Intensity values and colors used can be defined in the programming of the Lutron system. Refer 

to the LED Product Selection Tool for a list of compatible products (www.lutron.com/ledtool). 

HomeWorks QS (120V) 

QSE-CI-DMX5 

 

For more information on how to program DMX technology with a HomeWorks QS system, refer 

to the application note and supplementary training video located on the HomeWorks QS dealer 

site at http://resi.lutron.com. (Qualified Accounts only) 

  

                                                
5
 Requires a system keypad to control the centralized lighting zones of this device 

http://www.lutron.com/ledtool
http://www.lutron.com/ledtool
http://resi.lutron.com/
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4.0    Setting High and Low End Trim 
 

Some LED loads will require adjustments to be made to the dimming range of the dimmer in 

order to perform at the highest possible level for the end user. Adjustments of low end and high 

end trim settings of the dimming control eliminate potential undesirable issues such as 

flickering, shimmering, pop-on, or dead travel.  

Recommended trim settings can be found, for all approved LED fixtures and loads, using the 

LED Product Selection Tool at http://www.lutron.com/ledtool. Trim settings can also be 

determined by on-site testing with the aid of the system programming utility. Required trim 

settings can be entered on a per zone basis using the system programming utility and are 

changed on a device level during system database transfers. 

 

4.1   Adjusting Trim Settings in the RadioRA 2 Programming Software 

 

Low and High end trim can be adjusted using the RadioRA 2 Programming Software on a 

control by control basis. To adjust these trim settings, locate the dimming control to be adjusted, 

within the Design tab of the software, and then right-click on the image of the control. 

 

In the menu that appears, click on Advanced Settings. 

http://www.lutron.com/ledtool
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The Advanced Settings window will appear for the dimming control. Low end and high end trim 

settings can be adjusted here, as needed.  

Some LED fixtures or lamps may require the phase control of adaptive phase control devices to 

be locked in either Reverse or Forward phase, as opposed to Auto-Detect. Phase control can 

be set in Advanced Settings. Only change this setting if directed to do so by the LED Report 

Card for the specific LED fixture or lamp that is being controlled. 

4.2   RadioRA 2 Low End Trim Tool 

 

If a customer is not satisfied with the performance of LED lamps at low end, the RadioRA 2 

Programming Software offers a tool to aid in finding an appropriate low end. This tool will allow 

you to modify the low end in real time to find a satisfying low end. 

Locate the Verify Low End feature in the Tools menu of the software. 
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In the window that appears, select the lighting zone, on the left, that you would like to edit the 

low end trim setting for. Once the appropriate zone has been selected, click on Find Better Low 

End to begin the adjustment. 
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The low end can be tuned using the Auto Increment feature or by Fine Tuning the low end 

setting manually using the up and down arrow buttons in the software. Once the desired low 

end is achieved, click on Save Low End.  

NOTE: Clicking on Save Low End passes the new Low End Trim setting to the device. A 

database transfer is not required. 
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4.3   Adjusting Trim Settings in the HomeWorks QS Programming Software 

 

Low and High end trim can be adjusted using the HomeWorks QS Programming Software on a 

zone by zone basis. To adjust these trim settings, locate the dimming control to be adjusted, 

within the Design Controls tab of the software, and then click on View Properties for the 

corresponding Device Location. 

 

The low and high end trim settings for each local dimming control can be found in the Properties 

tab of the Device Location Properties window. 

 

Low and high end trim settings can also be adjusted at the load, as opposed to the control, by 

finding the appropriate load in the Design Loads tab of the programming software. Note that it 

may be necessary to use the Customize Columns menu to make the trim settings visible (check 

the boxes for Low and High End). 
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4.4   HomeWorks QS Low End Trim Tool 

 

If a customer is not satisfied with the performance of LED lamps at low end, the HomeWorks 

QS Programming Software offers a tool to aid in finding an appropriate low end. This tool will 

allow you to modify the low end in real time to find a satisfying low end. 

Locate the Verify Dimmer Low End feature in the Tools menu of the software. 

 

In the window that appears, select the lighting zone, on the left, that you would like to edit the 

low end trim setting for. Once the appropriate zone has been selected, click on Find Better Low 

End to begin the adjustment. 
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The low end can be tuned using the Auto Increment feature or by Fine Tuning the low end 

setting manually using the up and down arrow buttons in the software. Once the desired low 

end is achieved, click on Save Low End. 

NOTE: Clicking on Save Low End passes the new Low End Trim setting to the device. A 

database transfer is not required. 

 

5.0    Using an LUT-LBX as an Active Load 
 

Dimming LEDs can prove to be difficult. In some instances, instability such as flickering or 

issues (particularly at low end) with the LED load can be corrected by adding a simulated 

resistive load into the dimming control output circuit. Lutron manufactures an active load device, 

the LUT-LBX. The LUT-LBX is a 10W solid state load which simulates a 50W resistive load on 

the output of the dimming control. 

LED loads will meet the minimum load requirements while in the ON or conducting state but, 

when attempting to turn the LED load OFF, can pose minimum load issues for the dimming 

control. This issue often manifests itself when the LED load never fully turns off even when the 

dimming control is sent into the OFF state. The LUT-LBX provides more than enough simulated 

resistive load to meet the minimum load requirements of all Lutron dimming controls. 

The LUT-LBX must be either surface or recessed mounted. Surface mounting would require a 

provided junction box (Lutron P/N 241-496). For more information, refer to the specification 

submittal document: http://www.lutron.com/TechnicalDocumentLibrary/LUT-LBX-1.pdf. 

http://www.lutron.com/TechnicalDocumentLibrary/LUT-LBX-1.pdf
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6.0    FAQs 
 

If the information contained on the packaging indicates that the LED lamp is dimmable, 

does that mean that it will be compatible with Lutron Residential Systems dimming 

products? 

The definition of compatible is one that is subjective. If a lamp only dims to a low end of 50%, is 

that truly dimmable? While the light level technically changes, Lutron strives to provide its 

customers with a high quality solution driven by high performance. Lamps must have a wide 

range of dimming without flicker, shimmer, and pop-on in order to meet the criteria of being 

compatible with our dimming products. Ideally, the dimming range and performance should be 

very close or essentially equivalent to that of an incandescent lamp. 

 

 

I cannot find a specific lamp or fixture on the LED Product Selection Tool. Now what do I 

do? 

With the multitude of lamps and fixtures on the market, as well as the time needed to 

adequately test each lamp and fixture with the multitude of Lutron product, there will always be 

lamps and fixtures that Lutron has not yet tested. In cases like this, where an end user is 

adamant about control of a specific lamp or fixture, performing your own testing will be the best 

option.  

Consider each lamp or fixture to be a 100W load (to account for the most extreme repetitive 

peak inrush currents), and connect a dimmer to the circuit. Depending on the load type and 

application, the products previously listed can be used as test samples. Test the lamps through 

the entire dimming range. Flickering, shimmering, or dead travel (no change in intensity while 

the local Maestro LEDs move up or down) may occur at low or high end. The low end and high 

end trim of each individual dimmer can be adjusted using the RadioRA 2 and HomeWorks QS 

programming software to minimize or eliminate this effect. 

Be sure that the total number of 100W lamps/fixtures does not exceed the incandescent 

maximum rating of the dimmer zone. If it is exceeded, you may need to add a power booster. 

Be sure to test the performance with the booster in place as the booster circuitry may interact 

with the lamps/fixtures differently than the control would alone. 


